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1. Zielsetzung 
 
Bei diesem Dokument handelt es sich um eine Anleitung für die ordnungsgemäße Nutzung der 
webbasierten Datenaustauschplattform, die « Anbieter » unter Bezugnahme auf den 
Königlichen Erlass vom 31.05.2016 und den Erlass der FANK vom 24.11.2016 für die 
Einreichung ihres Selbstüberwachungsprogramms bei der Regulierungsbehörde zu verwenden 
haben. Labors können das Webtool nutzen, um Messungen für ihre Auftraggeber („Anbieter“) 
hochzuladen, die ihrerseits die Daten einsehen oder exportieren können. 
 
 
2. Anwendungsbereich 
 
Umsetzung des Königlichen Erlasses vom 31. Mai 2016 über den Schutz der Gesundheit der 
Bevölkerung hinsichtlich radioaktiver Stoffe in Wasser für den menschlichen Gebrauch. 
 
 
3. Anleitung 
 
Die Webplattform für den Datenaustausch ist über den folgenden Link zugänglich: 
https://dxp.fanc.be/ 
 
 
3.1. Anlegen eines Kontos 
 
Ab dem 01.04.2019 muss über CSAM1, eine Schnittstelle, die es Organisationen ermöglicht, die 
Rollen zu verwalten, die sie ihren Nutzern zuweisen möchten, um den Zugang zu Anwendungen 
der belgischen Regierung zu ermöglichen, zu denen auch die Datenaustauschplattform der 
FANK (FANC DXP) gehört, ein Identifikator oder Konto erstellt werden. Die Benutzer können 
sich über Identifizierungstechnologien wie e-ID und ItsMe mit CSAM verbinden. 
 
Wenn Sie mit der CSAM-Plattform nicht vertraut sind, sollten Sie die Dokumentation auf der 
CSAM-Website lesen, die in verschiedenen Sprachen verfügbar ist. Einen schnellen Überblick 
über die Funktionsweise der CSAM-Benutzerverwaltung finden Sie im CSAM Access Guide auf 
DXP: https://dxp.fanc.be/Help/AccessGuide. 
 
Kurz gesagt, die Organisation/das Unternehmen ernennt über die Anwendung eGov Role 
Management einen Chief Access Role Manager (Ihren gesetzlichen Vertreter oder CEO), der in 
der Regel einen oder mehrere Access Managers (Zugriffsmanager) zuweist. Die Rollen für die 
Anwendung der EDWD sind in der Anwendung eGov Role Management unter Interne 
Angelegenheiten, FANK, Trinkwasserrichtlinie zu finden. 
 
Sie können sich auch an die Personal- oder Buchhaltungsabteilung Ihrer Organisation wenden, 
um weitere Informationen zu erhalten, da die CSAM-Plattform auch für andere staatliche 
Anwendungen wie Sozialversicherung und Steuererklärungen verwendet wird und diese daher 
wahrscheinlich bereits damit vertraut sind. Sie sollten in der Lage sein, Ihnen mitzuteilen, wer 
die Zugriffsmanager in Ihrer Organisation sind. 
 
 
  

 
1 HINWEIS: Bis zum 31.12.2019 gilt eine Übergangsfrist für die Verknüpfung bestehender Altkonten 
(und ihrer Inhalte) mit den neuen CSAM-Konten. Es wird dringend empfohlen, die beiden Konten 
vor diesem Datum zu verknüpfen (§ 3.2.1 und § 3.2.1.1). 



2022-06-10-JC-SNOO-7-4-4-DE   5/34
 

3.2. Anmeldung 
 
Die Anmeldung ist nur mit einem gültigen CSAM-Login möglich (siehe § 3.1). In einigen 
Sonderfällen kann ein lokales Konto zugewiesen werden, z. B. um einem Benutzer, der keinen 
belgischen Personalausweis besitzt, eine Rolle zuzuweisen (Näheres finden Sie im Leitfaden für 
den Zugang). 
 
3.2.1. Assistent bei der ersten CSAM-Anmeldung (FANC DXP) 
 
Bei der ersten Anmeldung auf der CSAM-Plattform wird Ihnen ein Assistent angezeigt, mit dem 
Sie Ihr bestehendes DXP-Konto mit Ihrem CSAM-Login verknüpfen können. Wählen Sie 
« yes/Ja », wenn Sie bereits ein DXP-Konto haben. Anderenfalls wählen Sie « no/Nein ». 
 

 
Abbildung 1: CSAM vs existing account 

3.2.1.1. Antwort « YES/JA » in Bezug auf den Assistenten bei der ersten Anmeldung auf der 
CSAM-Plattform 
Wenn Sie in Schritt 3.2.1 « YES/Ja » gewählt haben, geben Sie Ihre bestehenden Zugangsdaten 
ein und melden sich an. 
 

 
        Abbildung 2: CSAM / existing account „Yes“ 

Nach erfolgreicher Anmeldung erhalten Sie die Meldung « Account linking succeeded » 
(Kontoverknüpfung erfolgreich).  
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Abbildung 3: CSAM / existing account linked 

3.2.1.2. Antwort « NO/NEIN » in Bezug auf den Assistenten bei der ersten Anmeldung auf 
der CSAM-Plattform 
Wenn Sie in Schritt 3.2.1 « no/Nein » gewählt haben, müssen Sie die Registrierung Ihres Kontos 
abschließen. Der Vor- und Nachname wird automatisch eingefügt; wenn Ihre E-Mail-Adresse 
im belgischen Nationalregister (NR) bekannt ist, wird sie ebenfalls eingefügt, Sie müssen sie 
jedoch ein zweites Mal eingeben, um sie zu bestätigen. Wenn Sie sich mit einer anderen als 
der im Unternehmensregister bekannten E-Mail-Adresse anmelden möchten, können Sie dies 
tun, indem Sie in beide Felder eine andere E-Mail-Adresse eintragen. 
 

 
         Abbildung 4: CSAM / existing account „No/Nein“ 

Wenn Sie die Registrierung mit der gleichen E-Mail-Adresse abschließen, die im NR bekannt ist, 
werden Sie direkt eingeloggt, ohne dass eine weitere Überprüfung erforderlich ist. 
 

 
         Abbildung 5: CSAM account created 01 
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Wenn Sie die Registrierung mit einer anderen im NR bekannten E-Mail-Adresse abschließen, 
wird Ihr Konto erstellt, aber Sie erhalten eine E-Mail mit einem Link zur Überprüfung Ihrer  
E-Mail-Adresse. Sie müssen auf diesen Link klicken, bevor Sie sich anmelden können. 
 

 
         Abbildung 6: CSAM account created 02 

3.3. Anbieter-Modul (Suppliers) 
 
Dieses Modul enthält alle notwendigen Tools für den « Anbieter » (Supplier). 
 
3.3.1. Registrierung eines neuen Anbieters 
 
Wenn Ihre Organisation noch nicht in der EDWD-Datenbank vorhanden ist, muss sie registriert 
werden. Wählen Sie dazu in der Menüleiste « Supplier » (Anbieter) und « Register New 
Supplier » (Neuen Anbieter registrieren). 
 

 
  Abbildung 7: Supplier Application Module 

3.3.1.1. Suche in der Zentralen Datenbank der Unternehmen 
Unternehmen können mit der Zentralen Datenbank der Unternehmen (ZDU) gekoppelt werden. 
Dies ist für belgische Unternehmen obligatorisch, und auch ausländische Unternehmen müssen 
in der ZDU vertreten sein, wenn sie eine belgische Niederlassung haben. 
 
Auch Geschäftseinheiten können mit der ZDU gekoppelt werden (nicht obligatorisch, aber 
empfohlen, falls vorhanden). Geben Sie die ZDU-Nummer des Unternehmens oder der 
Geschäftseinheit in das entsprechende Feld ein, um die Suche zu starten (Abbildung 8). 
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Wenn Sie die Nummer nicht kennen, konsultieren Sie die Website der ZDU. Sie können die 
Website aufrufen, indem Sie auf den angegebenen Link „ZDU-Website aufrufen“ klicken. Die 
Suche kann über Stichwörter erfolgen (Abbildung 9). 
 
Wählen Sie die ZDU-Nummer Ihrer Organisation aus der Liste aus. Wird die ZDU-Nummer nicht 
angezeigt, haben Sie vom CSAM-Manager Ihrer Organisation möglicherweise nicht die richtige 
Rolle für die EDWD erhalten. 
 

 
         Abbildung 8: Lookup CBE number – part 01 

 
Abbildung 9: Lookup CBE number – part 02 

ZDU Public Search liefert alle Unternehmens- und Geschäftseinheiten, die mit den 
eingegebenen Stichwörtern in Verbindung stehen. 
 

 
Abbildung 10: Lookup CBE number – part 03 

Wird eine ZDU-Nummer in das Feld « Suche nach ZDU-Nummer » eingegeben, zeigt die 
Anwendung der FANK eine Liste aller Geschäftseinheiten an, die mit dieser 
Unternehmensnummer verbunden sind (Abbildung 10). Der Benutzer kann entweder die 
entsprechende Einheit mit einem Doppelklick aus der Liste auswählen, um sich anzumelden, 
oder auf « Schließen » klicken, um die sich zu registrieren und die Unternehmenseinheit zu 
verwenden. 
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Abbildung 11: Lookup CBE number – part 04 

3.3.1.2. Auswahl einer ZDU-Nummer eines Unternehmens 
Wird eine ZDU-Unternehmensnummer eingegeben oder ausgewählt, werden die 
entsprechenden Daten der Unternehmenseinheit aus der ZDU in den Bereich « Enterprise 
Data » (Unternehemenseinheit) importiert. Alle Felder im Abschnitt « Business Unit Data » 
(Geschäftseinheit) sind noch leer und müssen ausgefüllt werden. Der Benutzer muss dieselben 
Daten manuell im Abschnitt « Enterprise Data » eingeben. In diesem Fall wird die 
Corporate Unit als « Anbieter » (Supplier) registriert! Die Adresse der Business Unit 
(Geschäftseinheit) gilt als offizielle (Korrespondenz-)Adresse des Anbieters. 

3.3.1.3. Auswahl einer ZDU-Nummer einer Geschäftseinheit 
Wird eine ZDU-Nummer einer Geschäftseinheit eingegeben oder ausgewählt, werden die 
entsprechenden Daten der Geschäftseinheit aus der ZDU in den Abschnitt « Business Unit 
Data » (Daten der Geschäftseinheit) und die Daten der Unternehmenseinheit in den Abschnitt 
« Enterprise Data » (Unternehmensdaten) importiert. In diesem Fall wird die Business 
Unit/Geschäftseinheit als « Anbieter » (Supplier) registriert! Die Adresse der Business 
Unit (Geschäftseinheit) gilt als offizielle (Korrespondenz-)Adresse des Anbieters. 

3.3.1.4. Unternehmen ohne ZDU-Nummer 
Ausländische Unternehmen ohne ZDU-Nummer müssen das Kontrollkästchen « Suche nach 
Unternehmen in der ZDU » (Lookup enterprise/business in CBE) deaktivieren. Nach der 
Auswahl des Landes der Herkunft/Registrierung müssen alle Felder manuell ausgefüllt werden. 

3.3.1.5. Zusätzliche Angaben zur Organisation 
 
Abbildung 12 gibt einen Überblick über den Abschnitt « Additional Organisation Data » 
(Zusätzliche Angaben zur Organisation). Manche Felder sind Pflichtfelder (*), andere nicht. 
 

 « Supplier Types » (Art der Anbieter) 
Geben Sie an, zu welcher Art von Anbieter Ihr Unternehmen gehört: 
Lebensmittelsektor oder Trinkwasseranbieter. Wenn Sie beides sind, ist eine 
Mehrfachauswahl möglich, wählen Sie also beide Optionen. 

 
 « Preferred Language » (Bevorzugte Sprache) 

Wählen Sie, in welcher Sprache Sie kommunizieren möchten: Französisch, 
Niederländisch oder Englisch. Wenn eine Kontaktaufnahme erforderlich ist, wird 
die Erstkommunikation in der gewählten Sprache erfolgen. 
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 « Address contact person » (Adresse der Kontaktperson) 

Es kann vorkommen, dass Teile einer Geschäftseinheit, wie z. B. Labors oder 
Forschungs- und Entwicklungseinrichtungen, nicht in den Räumlichkeiten der 
Geschäftseinheit, sondern in der Nähe angesiedelt sind (z. B. ein Labor in einer 
anderen Straße oder mit einer anderen Hausnummer). Wird eine solche Adresse 
angegeben, wird sie zuerst und/oder für inoffiziell Zwecke verwendet. Die 
Adresse der Geschäftseinheit bleibt die offizielle Kontaktstelle. 

 
Wenn Sie fertig sind, klicken Sie auf die Schaltfläche « Submit Registration / Registrierung 
abschicken ». 
 

 
Abbildung 12: Registration supplier data 

3.3.1.6. Eindeutiger Anbietercode  
Bei jeder Registrierung eines Anbieters erhält dieser einen eindeutigen Identifikationscode. Bei 
Anbietern, die über ihre ZDU-Nummer registriert werden, besteht der eindeutige Code aus 
einem inkrementellen Zähler, gefolgt von ihrer ZDU-Nummer. Beispiel für die Föderalagentur 
für Nuklearkontrolle: 
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• ZDU = BE 2146.699.773; 
• Identifikationscode = 01BE2146699773 

 
Registrieren verschiedene Benutzer (verschiedene Konten) eine Unternehmens- oder 
Geschäftseinheit, die bereits eingereicht wurde, erhöht sich der Zähler jeweils um eins: 01, 02, 
usw. 
 
Dies kann der Fall sein, wenn verschiedene Abteilungen oder Bereiche für ihr eigenes 
Selbstüberwachungsprogramm (ACP) oder ihre eigene Überwachung zuständig sind und alle 
zu demselben Unternehmen oder derselben Geschäftseinheit gehören, aber keine ZDU-
Nummer haben. In diesem Fall wählt und registriert jeder Bereich (der ein Konto erstellt hat) 
dieselbe Geschäftseinheit, aber jeder Nutzer erhält seinen eigenen Code. 
 
Dieser Code wird auch für die eindeutige Identifizierung jeder registrierten Stelle der Einhaltung 
(= PDC-Punkt, an dem die Parameterwerte erfüllt werden müssen) verwendet. 

3.3.2. Modul Selbstüberwachungsprogramm (Auto Control Programme) 
 
WICHTIGER HINWEIS: 
Sobald Sie auf « SUBMIT PROGRAMME » (PROGRAMM ÜBERMITTELN ) klicken, wird die 
Meldung des Selbstüberwachungsprogramms (Auto Control Programme Declaration) für den 
Anbieter übermittelt und infolgedessen durch das System GESPERRT. Änderungen sind nicht 
mehr möglich, bis die Agentur den Antrag geprüft hat. 
 
Sie können PDC-Punkte (Stellen der Einhaltung) und angehängte Dokumente hinzufügen und 
ändern, solange Sie nicht auf die Schaltfläche « Submit » (Einreichen) klicken. Wenn Sie die 
Anwendung verlassen oder sich abmelden, wird Ihre gesamte Arbeit gespeichert, so dass Sie 
Ihren Vorschlag für ein Überwachungsprogramm in mehreren Schritten einreichen können. 

3.3.2.1. Einen Anbieter wählen  
Rufen Sie EDWD/Anbieter/Selbstüberwachungsprogramm (EDWD / Supplier / Auto Control 
Programme) auf, um sich anzumelden sowie Analysen zu ändern und einzureichen. Für jeden 
registrierten Anbieter kann ein Selbstüberwachungsprogramm (ACP) eingereicht werden. 
 

 
   Abbildung 13: Supplier Applications module 

Wählen Sie den Anbieter aus der Dropdown-Liste « Enterprises » (Unternehmen) und/oder 
« Business units » (Geschäftseinheit) aus, wenn für Ihr Konto mehrere registriert wurden. 
Wenn kein Anbieter aufgelistet wird, müssen Sie ihn zunächst registrieren (§ 3.3). 
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Abbildung 14: Supplier selection - Part 01 

 
Abbildung 15: Supplier selection - Part 02 

Nach der Auswahl werden fünf Registerkarten angezeigt: ACP Status (Status 
Selbstüberwachungsprogramm), PDC List (Liste der PDC-Punkte), Water/Food Ratio (Verhältnis 
Wasser/Lebensmittel), Attachments (Anhänge) und Analysis Labo (Analyselabor); Abbildung 
16. 
 

 
Abbildung 16: Auto control programme Status tab 
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3.3.2.2. Kodierung von PDC-Punkte (Stellen der Einhaltung) 
Wählen Sie die Registerkarte « PDC List » (Liste der PDC-Punkte)  und dann « Add new 
record » (Neuen Datensatz hinzufügen), um eine Stelle der Einhaltung (PDC, Point of 
Compliance) zu kodieren. 
 

 
Abbildung 17: PDC List tab – Part 1 

Der eindeutige Identifikationscode der Stelle der Einhaltung wird automatisch generiert und 
basiert auf dem eindeutigen Code Ihres Anbieters + einem Zähler. Gegebenes Beispiel: 
01BE2146699773-A01. 
 
Alle Felder sind Pflichtfelder und müssen von oben nach unten ausgefüllt werden. Nach Eingabe 
der GPS-Koordinaten in Dezimalgraden2 wählt das System automatisch « Locality » (Ort) und 
« NUTS-Code » aus. Ist der vorgeschlagene Ort oder der NUTS-Code nicht korrekt, überprüfen 
Sie zunächst die GPS-Koordinaten. Sind die Koordinaten korrekt, können der Ort und der NUTS-
Code bei Bedarf manuell geändert werden (Abbildung 18). 
 

 
Abbildung 18: Information zum Ort 

  

 
2 HINWEIS: Achten Sie darauf, dass Sie die Koordinaten für Längen- und Breitengrad nicht vertauschen. 
Sie können diese mit der Funktion « Toggle PDC Map » überprüfen (§ 3.3.2.3). 
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Bei einigen Feldern finden Sie ein Informationssymbol  (z.B. bei « Catchment » 
(Einzugsgebiet), « Characterisation » (Charakterisierung), etc.). Wenn Sie mit dem Mauszeiger 
darüberfahren, erscheint ein Pop-up-Fenster mit zusätzlichen Erläuterungen (siehe Abbildung 
19; z. B. Erläuterungen zu den Auswahlmöglichkeiten in der zugehörigen Dropdown-Liste). 
 

 
Abbildung 19: Informationsindex  

Wird im Feld « Catchment » (Einzugsgebiet) der Wert « Aquifer » (Grundwasserleiter), 
« Mixed-Aquifer » (gemischt-Grundwasserleiter) oder « Mixed-Mixed » (Gemischt-Gemischt) 
ausgewählt, erscheinen zwei weitere Felder, nämlich « Aquifer name(s) » 
(Grundwasserleitername(n)) und « Groundwater body name(s) » 
(Grundwasserkörpername(n)) (Abbildung 20). In diesen (obligatorischen) Feldern müssen 
dann der/die Name(n) des/der Grundwasserleiter(s) und des/der Grundwasserkörper(s) 
ausgewählt werden. Die Felder sind mehrfach auswählbar (Abbildung 21). Sie sind nach 
Regionen gruppiert (Brüssel-Hauptstadt, Flandern und Wallonie). 
 

 
Abbildung 20: Felder „Grundwasserleitername(n)“ und „Grundwasserkörpername(n)“ - Teil 1. 

 
Abbildung 21: Felder « Grundwasserleitername(n) » und « Grundwasserkörpername(n) » - Teil 2. 
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Das Feld « Are treatment filters in place ? » (Sind Behandlungsfilter vorhanden ?)  ist 
obligatorisch. Kreuzen Sie dies an, wenn das Wasser nach dem Abpumpen von Grundwasser, 
Oberflächenwasser oder anderem über Filter wie Sandfilter, Aktivkohle usw. behandelt wird 
(Abbildung 22). 

 
Abbildung 22: Feld « Sind Behandlungsfilter vorhanden? ». 

Die Summe der Prozentsätze im Abschnitt « Water Origin » (Herkunft des Wassers) und im 
Abschnitt « Water destination » (Bestimmung des Wassers) muss für jeden Abschnitt 
(Abbildung 23) 100 ergeben. 
 
Handelt es sich um eine erste oder neue PDC-Punkt, ist die « Sample Rate for Ta/Tb, H3 und 
Rn222 » (Probenahmerate für Ta/Tb, H3, Rn222) immer gleich. Die Sample Rates können sich 
nur unterscheiden, wenn eine Messperiode von mindestens 4 Jahren durchgeführt wurde und 
mindestens zwei Messergebnisse enthält (siehe Leitfaden Frequenzreduzierung beantragen). 
 
Am Ende können im Feld « Comment » (Kommentar) eine Rechtfertigung oder Begründung für 
die Wahl der PDC-Punkte oder zusätzliche Informationen hinzugefügt werden. 
 
Die Funktion « Enabled » (Aktiviert) ermöglicht es, registrierte PDC-Punkte zu „deaktivieren3“ 
(aktiviert nicht angehakt) oder wieder zu „aktivieren“. Für eine neue PDC-Punkt ist diese 
Funktion standardmäßig auf „aktiviert“ gesetzt. 
 

 
3 ACHTUNG: Registrierte und genehmigte PDC-Punkte können nie gelöscht werden, da sie (geografisch) 
eindeutig und mit Messwerten in der Datenbank verknüpft sind. Wird eine PDC-Punkt in Zukunft nicht 
mehr verwendet (z. B. Schließung des Geschäftsbereichs, Ersatz durch eine andere Stelle der Einhaltung, 
...), muss der Punkt „deaktiviert“ werden. 
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Abbildung 23: Felder « Wasserherkunft », « Wasserziel » und « Probenahmerate ». 

Drücken Sie die Schaltfläche « Update » (Aktualisieren), um sie in der Datenbank zu speichern, 
und « Add new record » (Neuen Datensatz hinzufügen), um die nächste PDC-Punkt zu 
kodieren4. Wenn Sie fertig sind, werden alle kodierten Punkte aufgelistet (Abbildung 24). 
 

Abbildung 24: PDC List tab – Part 02 

 
4 HINWEIS: Jede PDC-Punkt hat einen eigenen, eindeutigen Satz von Koordinaten. Anders ausgedrückt: 
Keine PDC-Punkte kann den exakt gleichen Satz an Längen-/Breitengradkoordinaten haben. 
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3.3.2.3. Anzeige der Karte mit den PDC-Punkte (Toggle PDC Map)  
Die Funktion « Toggle PDC Map » (Auf Karte der PDC-Punkte umschalten) zeigt alle kodierten 
PDC-Punkte auf einer geografischen Karte an und ermöglicht es Ihnen, ihre Position visuell zu 
überprüfen. Alle « Enabled » (aktiven) PDC-Punkte erscheinen in grün, „deaktivierte“ Stellen 
erscheinen in Rot. Wählen Sie eine PDC-Punkt auf der Karte aus, um ihren eindeutigen Code 
anzuzeigen. Drücken Sie die Schaltfläche « Toggle PDC Map », um die Karte der PDC-Punkte 
zu schließen (Abbildung 25). 
 

 
Abbildung 25: Toggle PDC map 

3.3.2.4. Bearbeitung von Stellen der Einhaltung 
Solange noch keine Programmeinreichung erfolgt ist (Schaltfläche „Submit Programme / 
„Programm einreichen“ unten auf der Registerkarte („Auto Control Programme status / 
Selbstüberwachungsprogramm“), können alle kodierten PDC-Punkte durch Anklicken der 
Schaltfläche « Edit » (Bearbeiten) auf der rechten Seite bearbeitet werden (Abbildung 24). 

3.3.2.5. Export des Selbstüberwachungsprogramms 
Nachdem alle PDC-Punkte eingegeben wurden, kann das Selbstüberwachungsprogramm (ACP) 
in eine Excel-Tabelle exportiert werden, indem Sie auf die Schaltfläche « Export Auto Control 
Program to Excel » klicken. (siehe Abbildung 16). Alle eindeutigen Codes von Stellen der 
Einhaltung (PDC-Codes) sind in der exportierten Tabelle enthalten. Diese PDC-Codes werden 
zur Identifizierung jeder Probe benötigt und müssen daher auf jedem Probenblatt (für das 
Labor, das die Radioaktivitätsmessungen durchführt) angegeben werden. Die anderen 
Registerkarten des Selbstüberwachungsprogramms (ACP) werden ebenfalls exportiert 
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3.3.2.6. Verhältnis Wasser/Lebensmittel (Water/Food Ratio, WFR) 
Mit dieser Funktion können Sie für jedes von einer bestimmten PDC-Punkt stammende 
Lebensmittelerzeugnis, das Kontaktwasser oder zugegebenes Wasser verwendet, das 
Wasser/Lebensmittel-Verhältnis oder WFR-Wert (in Gewichtsprozent) eingeben. 
 
Klicken Sie auf die Schaltfläche « Add new record » (Neuen Datensatz hinzufügen), wählen Sie 
die entsprechende PDC-Punkt aus der Dropdown-Liste aus und füllen Sie die entsprechenden 
Felder aus. 
 

 
   Abbildung 26: Water to food ratio tab – Part 01 

Ein Wasser/Lebensmittel-Verhältnis5 von 45 % bedeutet, dass während des gesamten 
Prozesses 45 kg Wasser benötigt oder zugegeben wurden, um 100 kg des 
Lebensmittelendprodukts herzustellen (Abbildung 27). In das Feld « End Product Description » 
(Beschreibung des Endprodukts) geben Sie die allgemeine Bezeichnung des Produkts ein, z. B. 
Marmelade, Joghurt, Pommes Frites, Kekse, Suppe, Erfrischungsgetränk... 
 
Das Feld « Valid From » (Gültig ab) ist das Anfangsdatum, ab dem die kodierten Daten für das 
Endprodukt gültig sind oder zutreffen. Standardmäßig ist das aktuelle Datum vorausgewählt. 
Das Feld « Valid Until » (Gültig bis) bleibt leer (Abbildung 27). 
 
Fügen Sie so viele Datensätze wie nötig hinzu6. 

3.3.2.7. Bearbeitung eines Wasser/Lebensmittel-Verhältnisses (WFR) 
Solange noch keine Programmeinreichung erfolgt ist (Schaltfläche « Submit » (Einreichen) am 
unteren Rand der Registerkarte « Auto Control program status » (Status 
Selbstüberwachungsprogramm)), können alle kodierten Wasser/Lebensmittel-Verhältnisse 
durch Anklicken der Schaltfläche « Edit » (Bearbeiten) auf der rechten Seite geändert werden 
(Abbildung 28). 
 

 
5 ACHTUNG: Das WFR ist NICHT der Feuchtigkeitsgehalt des Endprodukts. Das WFR ist das Verhältnis 
(nach Gewicht) zwischen dem während des Produktionsprozesses hinzugefügten (oder verwendeten) 
Wasser und der Menge der produzierten Lebensmittel. Wasser, das den Produktionsprozess durch Filt-
rieren, Zentrifugieren, Trocknen usw. verlässt, darf nicht von der Gesamt-Wassermenge abgezogen wer-
den! Kurz gesagt: Fassen Sie das gesamte Wasser zusammen, das „zugegeben“ wurde (in kg/Tag), und 
teilen Sie es durch den Output (produzierte Lebensmittel in kg/Tag). Ein WFR-Wert kann von 1 Prozent 
bis zu mehreren hundert Prozent variieren. 
6 ACHTUNG: Jede PDC-Punk (die im Zusammenhang mit der Lebensmittelproduktion steht) muss min-
destens einen WFR-Wert haben! Sie kann auch mehrere WFR-Werte haben, wenn die PDC-Punkt mit 
mehreren Produktionsprozessen im Zusammenhang steht, die zu verschiedenen Endprodukten mit je-
weils anderem WFR-Wert führen. 
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Wenn in Zukunft die Daten zum Wasser/Lebensmittel-Verhältnis eines Produkts aufgrund eines 
anderen Produktionsprozesses aktualisiert werden müssen, muss das „Gültig bis“-Datum 
manuell ausgefüllt werden, um diesen Datensatz zu „schließen“, und es wird ein neuer 
Datensatz mit einer möglichen neuen Beschreibung und einem neuen Prozentsatz für das 
Gewichtsverhältnis erstellt. 
 

 
    Abbildung 27: Water to food ratio tab – Part 02 

 
Abbildung 28: Water to food ratio tab – Part 03 

3.3.2.8. Export von Wasser/Lebensmittel-Verhältnissen (WFR) 
Die Meldung des Wasser/Lebensmittel-Verhältnisses kann in eine Excel-Tabelle exportiert 
werden, indem Sie auf die Schaltfläche « Export ACP to Excel » klicken (Abbildung 16). Alle 
eindeutigen Codes von PDC-Punkte sind in der exportierten Tabelle enthalten. 

3.3.2.9. Anhänge 
Verschiedene Anhänge wie vereinfachte Schemata7 und andere relevante Informationen 
können mit Ihrem Selbstüberwachungsprogramm hochgeladen werden. Die Dateigröße ist auf 
20 MB begrenzt, und es sind nur die folgenden Dateierweiterungen zulässig: doc(x), xls(x), 
pdf, png und jp(e)g. 
 
Klicken Sie auf die Schaltfläche « Upload New File » (Neue Datei hochladen) und suchen Sie 
die gewünschte Datei auf Ihrem Computer. Eine Beschreibung der hochgeladenen Datei kann 
durch Klicken auf die Schaltfläche « Edit » (Bearbeiten) eingegeben werden. Hinweis: Bitte 
geben Sie der Datei einen kurzen beschreibenden Namen, bevor Sie sie hochladen. 
 

 
7 ACHTUNG: Ein vereinfachtes (Produktions-)Schema ist zwingend vorgeschrieben und muss vollständig 
sein. Der technische Leitfaden für die Ausarbeitung eines Vorschlags für ein Selbstüberwachungspro-
gramm (ACP) enthält Beispiele für Schemata für die Lebensmittelindustrie und für Trinkwasserhersteller. 
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Abbildung 29: Attachments – Anhänge 

3.3.2.10. Änderung von Anhängen 
Solange noch keine Programmeinreichung erfolgt ist (Schaltfläche „Submit Programme / 
Programm einreichen“) am unteren Rand der Registerkarte „Auto Control programme status / 
Status Selbstüberwachungsprogramm“), können alle hochgeladenen Anhänge durch Anklicken 
der Schaltfläche « Edit » (Bearbeiten) auf der rechten Seite geändert werden (Abbildung 29). 

3.3.2.11. Laboranalyse 
Mit dieser Funktion können Sie die Labors identifizieren, die die radioaktive Analyse der Proben 
durchführen. Wählen Sie « Add New Record » (Neuen Datensatz hinzufügen), um ein Labor 
hinzuzufügen. 
 

 
Abbildung 30: Analysis Lab tab – Part 01 

Analog zu § 3.3.1.1 können Sie die ZDU-Nummer des Labors (falls es in Belgien registriert ist) 
in das entsprechende Feld eingeben, um die relevanten Unternehmensdaten zu importieren. 
Ausländische Labors ohne ZDU-Nummer müssen das Kontrollkästchen « Suche nach 
Unternehmen in der ZDU » (Lookup enterprise/business in CBE) deaktivieren. Nach der 
Auswahl des Landes der Herkunft müssen alle Felder manuell ausgefüllt werden. 
 
Im Feld « Analyses Types »8 (Analysearten) können Sie die Analysen auswählen, die das Labor 
durchführt.  
 
Wenn Sie das Feld « Labo may upload measurement data on my behalf » (Labor darf 
Messdaten in meinem Namen hochladen) ankreuzen, werden Messungen, die von einem Labor 
hochgeladen werden, durch das Webtool akzeptiert, und der Anbieter erhält vom System eine 

 
8 HINWEIS: Alle in der Liste aufgeführten Analysearten (Stufe 1 = aT, bT, K40, bR, H3 und Rn222 und 
Stufe 2 = alle anderen) müssen mindestens einem Labor zugeordnet werden. Das bedeutet, dass alle 
13 Analysearten sichtbar sein müssen (Abbildung 32). Bei mehr als 99,9 % der Anbieter können alle 
Analysen einem Labor zugeordnet werden. 
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Benachrichtigung, dass neue Messungen vorhanden sind. Wenn Sie dies nicht auswählen9, 
werden Messungen von einem Laborkonto abgelehnt. 
 

 
  Abbildung 31: Analysis Lab tab – Part 02 

 
Abbildung 32: Analysis Lab tab – Part 03 

3.3.2.12. Bearbeitung der Daten eines Labors 
Die Liste Ihrer Partnerlabors kann jederzeit bearbeitet werden, auch wenn sich Ihr 
Selbstüberwachungsprogramm im Status « Submitted » (Eingereicht) befindet. Durch Klicken 
auf die Schaltfläche « Edit » (Bearbeiten) können Sie die Arten von Analysen ändern und 
Berechtigungen hochladen. Wenn Ihre Partnerschaft mit einem Labor beendet ist, können Sie 
den Eintrag löschen, indem Sie auf die Schaltfläche « Delete » (Löschen) klicken (Abbildung 
32). 
 

 
9 HINWEIS: Wenn nicht angekreuzt (wird nicht empfohlen), muss der Anbieter selbst alle Messungen 
– entsprechend den vorgegebenen Anforderungen – in der zwingend vorgeschriebenen DXP-EDWD-
Messvorlage kodieren und in DXP hochladen. 
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3.3.2.13. Einreichung eines Selbstüberwachungsprogramms 
Wie bereits in §3.3.2 erwähnt, sind nach Einreichung der Meldung des 
Selbstüberwachungsprogramms (ACP) für den Anbieter keine Änderungen mehr möglich, und 
die Meldung wird vom System gesperrt, bis die Agentur die Einreichung überprüft hat. 
 
Um die Meldung „einzureichen“ (Submit), wählen Sie die Registerkarte « Auto Control 
Programme Status » (Status Selbstüberwachungsprogramm) und drücken Sie die Schaltfläche 
« Submit Programme »10 (Programm einreichen) (Abbildung 33). 
 

 
Abbildung 33: Submit the Auto Control Programme Declaration 

Nach der Übermittlung wird der Agentur und dem Nutzer (über die E-Mail-Adresse des 
registrierten Kontos) eine Benachrichtigung über die Meldung zugesandt. 
 
Der Nutzer erhält eine E-Mail-Benachrichtigung, wenn die Meldung validiert und von der 
Agentur genehmigt oder abgelehnt wurde. Im letztgenannten Fall wird die Ablehnung mit einer 
Begründung und Empfehlungen versehen. Die Meldung des Selbstüberwachungsprogramms 
(ACP) wird „freigeschaltet“ (released), so dass der Anbieter den ursprünglichen Vorschlag 
bearbeiten und ändern kann. Die Anbieter müssen innerhalb von zwei Wochen einen neuen 
Vorschlag einreichen, der die vorgenannten Kommentare berücksichtigt. 
 
Der Anbieter beginnt mit seinem Selbstüberwachungsprogramm, sobald er von der Agentur 
eine Benachrichtigung mit der « Accepted » (Genehmigung) erhält. 

3.3.2.14. Bearbeitung des Selbstüberwachungsprogramms (ACP) 
Möchte ein Anbieter seine Meldung des validierten Selbstüberwachungsprogramms in Zukunft 
aufgrund von Umständen wie der Einführung eines neuen Lebensmittelherstellungsverfahrens 
oder der Nutzung anderer Wasserquellen bearbeiten, so kann er jeden Aspekt der Meldung 
jederzeit abändern. 

 
10 HINWEIS: Wenn einige der Daten des Selbstüberwachungsprogramms (ACP) nicht ausgefüllt sind, 
ist möglicherweise keine Schaltfläche « Submit Programme » (Programmeinreichung) sichtbar 
(verfügbar). In diesem Fall wird in einer Meldung auf die Mängel hingewiesen. 
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Nach Einreichung der neuen Meldung (mit Begründung) wird der Validierungsprozess wie in 
§3.3.2.13 beschrieben wiederholt. 
 
 
3.3.3. Anbietermanagement (Manage Supplier) 
 
Alle Änderungen betreffend die Benutzer und ihre Rollen werden über die Anwendung 
eGov Role Management vorgenommen (https://iamapps.belgium.be/rma/generalinfo). Der 
Anbieter ist verantwortlich für die Zuweisung der entsprechenden Rollen in seiner Organisation 
und für die Aktualisierung dieser Rollen, wenn Personen ersetzt werden (z. B. Ruhestand, 
Berufswechsel). 
 
Administrative Angaben oder Angaben zur Organisation können über die Funktion 
EDWD / Supplier / Manage Supplier (EDWD / Anbieter / Anbietermanagement) (siehe 
Abbildung 7 und § 3.3.1.5) geändert werden, z. B. die E-Mail-Adresse oder Telefonnummer des 
EDWD-Ansprechpartners. 
 
 
3.3.4. Liste der akkreditierten Labors 
 
Diese Funktion gibt eine Liste aller derzeit im DXP registrierten Labors aus, die Leistungen im 
Rahmen der vorgeschriebenen Radioaktivitätsanalysen von Wasser für den menschlichen 
Gebrauch anbieten. Diese Funktion befindet sich derzeit in der Entwicklung. 
 

 
Abbildung 34: Liste der Labors 

 
3.3.5. Einreichung von Messdaten 
 
Mit dieser Funktion können Anbieter Radioaktivitätsmessdaten hochladen. Die Funktionalität ist 
identisch mit derjenigen des Labormoduls. Näheres zur Verwendung finden Sie in § 3.4.3). 
 
Im Allgemeinen werden die Anbieter diese Funktion nicht nutzen, da die Messungen bereits 
von den Labors hochgeladen werden, die die Analysen anbieten und durchführen. Wenn die 
Daten von den Labors hochgeladen werden, erhalten die Anbieter eine Benachrichtigung vom 
System, wenn deren relevante PDC-Codes vorhanden sind. Wenn die Anbieter die 
Verantwortung für die Datenübermittlung selbst übernehmen wollen, können sie die Daten 
selbst hochladen11. 

 

 
11 HINWEIS: Radioaktivitätsdaten müssen gemäß den verbindlichen Richtlinien unter Verwendung der 
neuesten Version der « EDWD-Messvorlage » kodiert werden. Näheres entnehmen Sie bitte dem tech-
nischen Leitfaden « EWD Lab Analysis ». 
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3.3.6. Abfrage von Messungen 
 
Erfolgreich übermittelte Daten können eingesehen, gefiltert und exportiert werden. Klicken Sie 
auf das Tool « Consult measurements » (Messungen abfragen), um diese Funktion aufzurufen 
(Abbildung 34). 

3.3.6.1. Auswahl und Abruf von Messdaten 
Wählen Sie aus der Dropdown-Liste « Enterprise / Business Unit » (Unternehmen / 
Geschäftseinheit) Ihren entsprechenden Anbieter aus (wenn Sie Zugang zu verschiedenen 
Unternehmen oder Geschäftseinheiten haben). Es können nur die Daten des ausgewählten 
Unternehmens/der ausgewählten Geschäftseinheit abgefragt werden. 
 

 
Abbildung 35: Consult Measurements – Select Data 

Im Feld « Data File » können Sie nur Datensätze auswählen, die Sie selbst hochgeladen haben 
(siehe § 3.4.3.1 und § 3.4.3.3). Weitere Vorauswahlmöglichkeiten gibt es bei « Period Preset » 
(Voreingestellter Zeitraum) [(aktuelles) Jahr bis (aktuelles) Datum, 12 Monate oder 3 Monate 
rollierend]; oder Sie können ein « Begin date » (Anfangsdatum) und ein « End date » 
(Enddatum) wählen. 
 
Mit « Extra Filters » (Zusätzliche Filter), « Select all non-regular statuses » (Alle nicht-regulären 
Status auswählen) können auf den ausgewählten Datenzeitraum zusätzliche Vorauswahlfilter 
angewendet werden: 

 
• Normal – Highlighted (Normal – Hervorgehoben): GRD-Werte < 0,1 mSv/J und daher 

OK (grün) 
• High Value – No Evaluation Required (Erhöhter Wert – Keine Bewertung erforderlich): 

Werte, die ihren Parameterwert überschreiten (gelb) 
• High Value – Evaluation Required (Erhöhter Wert – Bewertung erforderlich): GRD-Werte 

> 0,1 mSv/J und noch nicht von der FANK bewertet (orange) 
• Evaluated – OK (Bewertet – OK): GRD-Werte > 0,1 mSv/J und von der FANK als OK 

bewertet (blau) 
• Evaluated – Not OK (Bewertet - Nicht OK): GRD-Werte > 0,1 mSv/J und von der FANK 

als Nicht OK bewertet (rot) 
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Unerwünschte Filter können durch Anklicken von « X » entfernt werden; « Clear status 
selection » entfernt alle zusätzlichen Filter. 
 

 
Abbildung 36: Consult Measurements – Extra Filters feature 

Drücken Sie die Schaltfläche « Retrieve Data » (Daten abrufen), um die Datenbank abzufragen; 
die entsprechenden Daten werden angezeigt. Wie in Excel können herkömmliche Datenfilter 
auf die „Kopfzeilen“ angewendet werden (klicken Sie auf den Trichter). 
 

 
Abbildung 37: Retrieved Data 

Durch Anklicken eines „PDC-Codes“ (z. B. 01BE2146699773-A06) werden nur die Ergebnisse 
für diese spezielle PDC-Punkt angezeigt. Mit dieser Funktion können Sie schnell die an anderen 
Terminen vorgenommenen Messungen für diese Stelle der Einhaltung anzeigen und 
überprüfen. 
 
Detaillierte Informationen zu einer Stelle oder einer Messung können durch Anklicken des 
kleinen Symbols im Vordergrund angezeigt werden (Abbildung 38): Angaben zum Absender 
oder zu der Person, die die Daten hochgeladen hat, Informationen des 
Selbstüberprüfungsprogramms zu dieser PDC-Punkt und Näheres zu den Daten (LIMS-ID,  
DF-Nummer usw.). 
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Abbildung 38: Detailed PDC-point record view – General information 

Auf der Registerkarte « Status History » (Statushistorie) finden Sie ein Protokoll aller 
(möglicherweise) für diese Stelle durchgeführten Bewertungen und Aktionen 
 

 
Abbildung 39: Detailed PDC-point record view – General information 

3.3.6.2. Export von Messdaten 
Wenn eine Datenbankabfrage durchgeführt wird (§ 3.3.6), kann das Ergebnis über die 
Schaltfläche « Export Currently Filtered data to Excel »12 (Aktuell gefilterte Daten nach Excel 
exportieren) nach Excel exportiert werden. Die exportierte Datei enthält – neben den auf dem 
Bildschirm sichtbaren Messungen – auch für jede PDC-Punkt die entsprechenden Informationen 
im Selbstüberprüfungsprogramm und die Besonderheiten des Datensatzes (LIMS-ID,  
DF-Nummer usw.). 
 
 
3.3.7. Modul „Zusammenfassender Bericht“ 
 
Mit dieser Funktion kann der Anbieter zusammenfassende Berichte erstellen und bearbeiten. 
Das Tool ist für die Einreichung des jährlichen zusammenfassenden Berichts an die 
Aufsichtsbehörde zu verwenden. Alle Berichte können exportiert werden. Das Tool befindet 
sich derzeit noch in der Entwicklung und wird voraussichtlich Anfang 2023 zur Verfügung 
stehen. 
 
 

 
12 HINWEIS: Wenn auf den Datensatz Filter angewendet werden und aktiv sind, werden nur die gefil-
terten (sichtbaren) Daten nach Excel exportiert. 
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3.4. Modul „Labor“  
 
Dieses Modul enthält alle notwendigen Tools für das „Labor“. 
 
 
3.4.1. Registrierung eines neuen Labors 
 
Bitte lesen Sie die ersten Abschnitte « § 3.1 Create Account » (Anlegen eines Kontos) und 
« § 3.2 Log in » (Anmeldung) und führen Sie sie aus. Wenn Sie fertig sind, rufen Sie die 
Anwendung „EDWD/Laboratory/ Register New Labo“ (EDWD/Labor/Neues Labor registrieren) 
auf, um ein Labor zu Ihrem Konto hinzuzufügen und zu registrieren. 
 

 
     Abbildung 40: Laboratory Applications Module 

Das Verfahren für die Registrierung eines Labors ist ähnlich wie bei der Registrierung eines 
« Supplier » (Anbieters, Näheres entnehmen Sie bitte § 3.3). Geben Sie die « Enterprise 
Number » (Unternehmensnummer) – oder die « Business Unit Number » (Nummer der 
Geschäftseinheit) - in das entsprechende Feld ein und starten Sie die Suche in der Zentralen 
Datenbank der Unternehmen (ZDU). 
 
Wählen Sie die ZDU-Nummer Ihrer Organisation aus der Dropdown-Liste aus. Wird die ZDU-
Nummer nicht angezeigt, haben Sie vom CSAM-Manager Ihrer Organisation möglicherweise 
nicht die richtige Rolle für die EDWD erhalten. 
 
Nach der Auswahl vervollständigen Sie die administrativen Angaben in den obligatorischen 
Abschnitten, d. h. Angaben zum Unternehmen und zur Geschäftseinheit, zum gesetzlichen 
Vertreter, zur Kontaktperson usw. und klicken Sie auf « Submit registration » (Registrierung 
abschicken). 
 
 
3.4.2. Management des Labors 

3.4.2.1. Allgemeine Informationen  
Dieser Bereich ermöglicht das Management und die Aktualisierung der allgemeinen 
administrativen Daten. Wählen Sie das entsprechende Unternehmen aus der Dropdown-Liste 
aus und übernehmen Sie die Änderungen. Wenn Sie fertig sind, klicken Sie auf die Schaltfläche 
« Update » (Aktualisieren) unten auf der Seite. 
 

3.4.2.2. Zulassung 
Jede Art von Analyse, die das Labor anbietet, muss mit dem entsprechenden 
Zulassungsdokument (ISO 17025) registriert werden. Wird ein Labor zum ersten Mal registriert, 
muss es seine vollständige Liste der Analysen zusammenstellen und zur Genehmigung 
vorlegen. Die bestehende Liste kann geändert und aktualisiert werden. 
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Klicken Sie auf « Add New Record » (Neuen Datensatz hinzufügen) und wählen Sie aus der 
Dropdown-Liste die Art der Analyse, die Sie hinzufügen möchten. Geben Sie die Daten « Valid 
from » (Gültig ab) und « Valid until » (Gültig bis) ein, fügen Sie bei Bedarf einen « Comment » 
(Kommentar) hinzu und drücken Sie auf « Update » (Aktualisieren) - (Abbildung 41). 
 

 
Abbildung 41: Laboratory Analysis Type List 

Als nächstes fügen Sie das Zulassungsdokument für die angegebene Art von Analyse hinzu. 
Drücken Sie auf den kleinen „Pfeil“ vor dem Analysedatensatz, um die Detailansicht zu öffnen, 
wählen Sie « Upload File » (Datei hochladen) und suchen Sie das Zulassungsdokument auf 
Ihrem Computer. Wenn Sie fertig sind, wählen Sie « Edit » (Bearbeiten) und fügen den Namen 
der Methode und die Seitenzahl des Dokuments hinzu (Abbildungen 42 und 43). 
 

 
Abbildung 42: Analysis Type Accreditation - Part 01 

 
Abbildung 43: Analysis Type Accreditation - Part 02 
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Wenn Sie alle Analysearten hinzugefügt haben, übermitteln Sie die Liste. Das System sendet 
eine Benachrichtigung und es folgt eine Bewertung. 
 

 
Abbildung 44: Submit Analysis Type Accreditation 

Das Labor erhält das Ergebnis des Bewertungsberichts so bald wie möglich. Wenn alles 
genehmigt wird, sind keine weiteren Maßnahmen erforderlich. 
 
Werden ein oder mehrere Elemente abgelehnt, wird das Labor aufgefordert, auf die 
eingegangenen Kommentare zu reagieren und Korrekturen oder Klarstellungen vorzunehmen. 
Datensätze vom Typ „Analyse abgelehnt“ können über « Edit » (bearbeitet) oder über 
« Delete » gelöscht werden. Wenn Sie Änderungen vorgenommen haben, wird die Schaltfläche 
« Submit Accreditation » (Zulassung einreichen) wieder angezeigt. Reichen Sie die 
Aktualisierung ein, sobald sie abgeschlossen ist. 
 

 
Abbildung 45: Analysis Type Accreditation - Part 03 

Die Aktualisierung der Liste der Analysearten ist obligatorisch, wenn die Zulassung ausläuft 
oder wenn andere Methoden verwendet werden. 
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3.4.3. Einreichung der Messdaten 
 
Mit dieser Funktion können Labors Radioaktivitätsmessdaten hochladen. Während des 
Hochladens wird die Datendatei einer Reihe von Validierungsregeln unterworfen. Wird ein 
Fehler gefunden, wird der Datensatz zurückgewiesen; anschließend wird ein ZIP-Paket mit den 
Verarbeitungsergebnissen zum Herunterladen generiert, das eine visuelle Rückmeldung und 
eine Beschreibung der gefundenen Fehler enthält. Ist die Verarbeitung erfolgreich, werden die 
Daten in die Datenbank übertragen. 

3.4.3.1. Hochladen einer Messdatendatei 
Da es möglich ist, dass ein Nutzer Rollen für verschiedene Unternehmen innehat, wählen Sie 
im Feld « Business Units » (Geschäftseinheit) den Akteur aus, in dessen Namen Sie die 
Messdaten hochladen möchten. 
 
Auf der Registerkarte « Templates » befindet sich die neueste Version der benötigten .xlsx-
Vorlage. Bitte prüfen Sie, ob die neueste Version verwendet wurde. Ist dies nicht der Fall, laden 
Sie die aktuellste Vorlage herunter13; Näheres zu den Änderungen finden Sie auf dem 
Tabellenblatt « Version History » (Versionshistorie) der Excel-Datei. 
 
Klicken Sie auf die Schaltfläche « Upload New Files » und rufen Sie das entsprechende .xlsx-
Datenblatt auf14. Nach dem Hochladen auf die Plattform verarbeitet das System die 
empfangenen Dateien nach dem FIFO-Prinzip (First-in-First-out). Je nach Auslastung kann es 
eine gewisse Zeit (bis zu mehreren Minuten) dauern, bis die eigentliche Bearbeitung des 
Datenblatts beginnt. 
 

 
Abbildung 46: Upload selection page 

  

 
13 HINWEIS: Wenn eine neue Vorlage verfügbar ist, empfehlen wir Ihnen, Ihre Messdaten – vor dem 
Hochladen – in die neueste Version zu übertragen; bitte tun Sie dies mit KOPIEREN -> INHALTE 
EINFÜGEN -> WERTE EINFÜGEN. 
14 HINWEIS: Es werden nur .xlsx-Excel-Dateien akzeptiert. Die Excel-Tabelle, die die Messdaten 
enthält, muss ihren Namen « Report-Sheet » beibehalten. Anderenfalls wird das System Ihre Datendatei 
nicht akzeptieren oder verarbeiten. 
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Drücken Sie die Schaltfläche « Refresh Grid », um den Bearbeitungsstatus zu aktualisieren. Auf 
der rechten Seite erscheint eine Meldung: nicht bearbeitet, in Bearbeitung, Bearbeitung 
abgeschlossen. Jeder Datensatz erhält eine eindeutige FANK-Datendateinummer (z. B. 
DF201900099). 
 

 
Abbildung 47: Processing status – Part 01 

3.4.3.2. Abgelehnte Messdaten 
Ist der Status rot, haben die Daten die Validierungsregeln nicht bestanden und müssen 
überprüft und korrigiert werden. Klicken Sie auf den „kleinen dreieckigen Pfeil“ vor der 
Statuszeile, um die Seite mit Informationen zu den Daten zu öffnen, und klicken Sie auf die 
Schaltfläche « Download file package ». Es wird eine ZIP-Datei des Datensatzes zum 
Herunterladen erstellt, die eine visuelle Rückmeldung und eine Beschreibung der Fehler enthält. 
 

 
Abbildung 48: Processing result file package 

Entpacken Sie nach dem Speichern die ZIP-Datei und suchen Sie die Excel-Datei mit den 
« Processing Results » (Verarbeitungsergebnissen) (z. B. DF201900099 Processing 
Results.xlsx). Jede rot hervorgehobene Zeile hat die Validierungsregeln nicht bestanden; die 
letzte Spalte gibt den Kodierungsfehler an. 
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Abbildung 49: Processing result file 

Überprüfen und korrigieren Sie die rot markierten Zeilen und laden Sie die vollständige 
Messdatendatei erneut hoch. 

3.4.3.3. Akzeptierte Messdaten 
Wenn der Status grün ist, werden die Daten in die Datenbank übertragen und ein neuer 
Datensatz kann hochgeladen werden. 
 
Wenn neue Daten in DXP importiert werden, füllt das System automatisch die Spalten « Locality 
Name » (Ortsname), « NUTS-Code », « Catchment » (Einzugsgebiet), « Decimal Longitude » 
(Dezimale Breite), « Decimal Latitude » (Dezimale Länge) und « Accuracy Type » (Art der 
Genauigkeit) aus oder ersetzt sie mithilfe der Daten aus dem Selbstüberwachungsprogramm. 
Informationen wie die eindeutige Nummer der Datendatei, die FANK-Identifikationsnummer 
der Messung, die für das Hochladen der Daten zuständige Person sowie Datum und Uhrzeit 
werden ebenfalls eingetragen.15.  
 

 
15 HINWEIS: Wenn die Akteure (Labor, Anbieter) auch lokal eine Kopie der Messdatendatei abspeichern 
möchten, wird empfohlen, die entsprechende DXP-Datendatei zu exportieren und zu verwenden , da 
diese Datei mit den genehmigten Daten des Selbstüberwachungsprogramms und DXP-
Überwachungsinformationen vervollständigt wird. 
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Abbildung 50: Uploaded file detail 

3.4.3.4. Löschung von Messdaten 
Messdaten können nicht einzeln geändert oder gelöscht werden. Wenn die Daten erfolgreich 
hochgeladen wurden, sich aber im Nachhinein als fehlerhaft herausstellen, müssen alle 
Datendateien (Data Files), die von diesen Fehlern betroffen sind, vollständig gelöscht werden 
(z. B. DF201900098, DF201900099…). Öffnen Sie die Informationsseite der Datendatei, klicken 
Sie auf « SysAdmin » und « Delete imported data » (Importierte Daten löschen). Wiederholen 
Sie diesen Vorgang, bis alle fehlerhaften Datensätze gelöscht sind, und laden Sie die neuen 
(verbesserten) Datensätze wieder hoch (§3.4.3.1). 
 

 
Abbildung 51: Delete uploaded file 

Wenn ein Datensatz akzeptiert wird, „sperrt“ das System diesen Datensatz nach einigen 
Wochen. Einmal gesperrt, kann er nicht mehr gelöscht werden. Zum Entsperren wenden Sie 
sich bitte an die Agentur (surveillance.dw@fanc.fgov.be). 



2022-06-10-JC-SNOO-7-4-4-DE   34/34
 

 
3.4.4. Abfrage von Messungen 
 
Erfolgreich übermittelte Daten können mit der Funktion « Consult Measurements » (Messungen 
abfragen) angezeigt, gefiltert und exportiert werden. Die Funktionalität ist identisch mit 
derjenigen des Anbietermoduls (Supplier Module). Näheres zur Verwendung finden Sie in 
§3.3.6). Nur von Ihnen selbst hochgeladene Daten können angezeigt oder exportiert werden. 
 
 
3.5. Fragen und Unterstützung 
 
Wenn Sie Fragen haben, Hilfe bei der Nutzung der Datenaustauschplattform benötigen oder 
Probleme bei der Bearbeitung Ihres Selbstüberwachungsprogramms haben, wenden Sie sich 
bitte an surveillance.dw@fanc.fgov.be. 
 
 
4. Terminologie 
 

• CSAM: Common Secure Access Management 
• DXP: Data eXchange-Plattform (Datenaustauschplattform) 
• eID: elektronischer Personalausweis 
• ItsMe: Anwendung, die eine sichere, einfache und zuverlässige Bestätigung Ihrer 

Identität und die anschließende Genehmigung von Transaktionen ermöglicht 
• NR: Nationale Registrierungsnummer 
• Captcha: Familie von Turing-Tests zur automatischen Unterscheidung zwischen einem 

menschlichen Benutzer und einem Computer 
• EDWD: Euratom-Trinkwasserrichtlinie (Euratom Drinking Water Directive) 
• ZDU: Zentrale Datenbank der Unternehmen  
• CBE: Crossroad Bank for Enterprises (siehe oben) 
• KBO: Kruispuntbank voor Ondernemingen (siehe oben) 
• BCE: Banque-Carrefour des Entreprises (siehe oben) 
• ACP (SÜP): Auto Control Programme (Selbstüberwachungsprogramm) 
• FANK: Föderalagentur für Nuklearkontrolle 
• Anbieter (Supplier): jedes Unternehmen oder jede juristische Person, die Wasser 

herstellt, das für die Herstellung von Lebensmitteln verwendet oder als Trinkwasser 
verteilt wird 

• PDC: Point of Compliance (Stelle der Einhaltung) 
• NUTS-Code: Nomenclature des unités territoriales statistiques (Systematik der 

Gebietseinheiten für die Statistik)  
• WFR: Water/Food ratio (Wasser/Lebensmittel-Verhältnis) 

 
 
5. Anlagen und zu verwendende Formulare 
Entfällt. 
 
    
 
 


